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このドキュメントでは、Autodesk MotionBuilder 2013 に関する既知の制限事項、問題、および修正に

ついて説明します。本リリースをインストールする前に、このドキュメントを必ずお読みください。参照用と

して、このリリース ノートをハード ディスクに保存するか、印刷してください。 

目次 

追加のリソース   ............................................................................................................................ 1

修正内容   .................................................................................................................................... 1

制限事項と回避策   ....................................................................................................................... 4

注意事項   .................................................................................................................................... 8

追加のリソース  
MotionBuilder 2013 のアンインストールとインストールの詳細な指示については

、http://www.autodesk.com/motionbuilder-faq-2013-jpn を参照してください。 

本製品に関するすべてのドキュメントとリソースは、http://www.autodesk.com/motionbuilder-
documentation (英語)を参照してください。 
認定ハードウェアに関しては、http://www.autodesk.com/motionbuilder-hardware (英語)を参照してく

ださい。 

このリリースに関する問題を報告するには、http://www.autodesk.com/motionbuilder-bugreport (英
語)を参照してください。 

その他のリソースについては、http://www.autodesk.com/motionbuilder-learningpath (英語)を参照

してください。 

修正内容 
次の一覧は、今回のリリースで修正された問題に関するバグ番号とその説明です。 

修正内容 

バグ番号 説明 

MOBU-494 Now possible to remove a whole menu directly with FBMenuManager(). 

MOBU-290 Materials are named differently depending on how they are created. 

MOBU-586 Numeric values no longer appear in Fcurve editor. 
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修正内容 

バグ番号 説明 

MOBU-536 Auxiliary effectors not plotting or parenting as expected. 

MOBU-647 Cannot re-order takes in Navigator. 

MOBU-640 Cannot drive the right tangent of a curve using code. 

MOBU-646 Ordeviceskeleton sample does not include new global/local settings for the sample 
hybrid skeleton. 

PEEO-1832 Crash selecting two files in Save dialogue. 

MOBU-416 Not all object/camera properties are supported in Story mode. 

MOBU-383 FPS setting for Video>Image Sequence cannot be modified. 

MOBU-352 Layered Texture not working correctly with Alpha / Additive Blending. 

MOBU-304 Crash when merging layers with option set to Delete Merged Layers. 

MOBU-274 Crash on load when time warps are associated with non-existent takes. 

MOBU-1000 Cannot access reach sliders for the Control Rig Effectors in Character Controls 
Window when Story Mode is active. 

PEEO-1516 FBPropertyAnimatableTimeCode.asString() has space in time code string. 

PEEO-1836 Crash when Replace Control Rig is checked on Load Character Animation. 

PEEO-1835 Crash when Load Character Animation checked and no rig exists. 

PEEO-1905 No way to get time code string when transport control displays frames. 

MOBU-753 Text associated with key frames does not stay aligned to key frames in Fcurve editor. 

MOBU-510 Right click options not working on scripts in Navigator. 

MOBU-226 Instability caused by double-underscore in take name. 

MOBU-77 Character Controls single click should always toggle selection. 

MOBU-556 Deleting Character using script causes instability. 

MOBU-516 Panning in Fcurve editor will also move key frames with 3ds Max shortcuts. 

MOBU-197 Story ghosts are not visible in models only view. 
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修正内容 

バグ番号 説明 

MOBU-295 Crash deleting track with File New. 

MOBU-399 Constraint order is lost on save. 

MOBU-375 Ghost clip does not have rotational values. 

MOBU-339 IK/FK sliders not keying with auto key turned on. 

MOBU-291 Object selection in large scenes very slow. 

MOBU-202 Audio hardware buffer reached quickly. 

MOBU-277 Auto key not creating red key frames for full body keys. 

MOBU-163 Undo not working on visibility. 

MOBU-388 No prompt for multi-layer before keying on base layer. 

MOBU-324 Switching to x-ray mode is slow. 

MOBU-176 Save selection is selecting entire hierarchy. 

MOBU-272 Keep at least one key frame on Character extension. 

MOBU-149 No real time updates on reach and pull sliders. 

MOBU-319 Timeline settings not kept when opening new scenes. 

MOBU-289 Joints pop when using character additive subtracks in Story. 

MOBU-346 Camera interest not respected in Story tracks. 

MOBU-331 Take properties are duplicated on save. 

MOBU-309 Set visibility animation lags. 

MOBU-366 Incorrect shading on any shape animation due to bad normals evaluation. 

MOBU-382 AMC import resets joint properties. 

MOBU-286 ASF export/import adds extra dummy nodes. 

MOBU-961 Full body key visibility issue when auxiliary effectors are added. 

PEEO-1935 FBTextureMapping modes not set correctly. 
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修正内容 

バグ番号 説明 

MOBU-1137 Character controls plot options in menu are cut off. 

MOBU-1135 Cannot return from full screen mode if mouse is outside Viewer window. 

MOBU-1066 Python SDK out of sync with UI for image sequence frame rates. 

MOBU-1035 FBRenderer.Pick causing instability. 

MOBU-759 Auxiliary effectors do not plot as expected. 

MOBU-671 No way to query the current KeyingGroups list. 

MOBU-619 Not always possible to set Discontinuity Left/Right for keys. 

MOBU-514 Skin weights are not transferred when saving with FBApplication. 

PEEO-292 Precision errors over long periods of time with rates 23.976 and 29.97. 

MOBU-302 Story clips do not retain constraint information when re-imported. 

MOBU-935 Unable to launch MotionBuilder with a Python script via command line. 

MOBU-925 FBObjectPose constructor does not work with string argument. 

MOBU-909 Crash deleting items by namespace with Python. 

MOBU-891 Using the function GetPropertyValue() from the FBObjectPose() returns a 
BoostPython error. 

MOBU-890 FBObjectPose::IsPropertyPoseable() will crash MotionBuilder. 

MOBU-666 No quick way to deselect objects using the API. 

MOBU-645 Live state of device is not saved when saving a custom device using Python. 

制限事項と回避策 
次の一覧は、今回のリリースでの制限事項と回避策に関するバグ番号とその説明です。 
 

制限事項と回避策 

バグ番号 説明 
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制限事項と回避策 

バグ番号 説明 

PEEO-2244 FBAnimation node keys do not display in Fcurves. 

PEEO-2272 ORSDK sample ortoolcharacter not working correctly. 

PEEO-1825 

FBVisualContainer class issues:  
Running the sample script “Container.py” twice crashes application 
Unable to trigger kFBDragAndDropEnd event 
DragAndDrop Event variable PosX and PosY is always 240 and 0 

MOBU-374 Crash opening some files when takes have had custom properties deleted. 

MOBU-1168 Locking base layer causes offsets on keys created on additional layers. 

MOBU-1161 
Character extension asset not added when drag and dropped in Viewer.  
Workaround: Character extensions can also be added by right clicking on the character 
name in the Navigator and selecting Create Character Extension from the menu 

MOBU-1160 FBRetrieve starts executing before it has access to the scene causing incorrect data 
retrieve. 

MOBU-1158 Global rotation only when scrubbing the axis values in the Viewer. 

MOBU-1153 Python – FBAsset Mng – listed as available class in user guide. 

MOBU-1138 Torso remains pinned when rotating hips effector in full body mode with HIK solver. 

MOBU-1134 Having Video Output online can cause viewer problems with multi pane views. 

MOBU-1002 Control Rig>Rig Look> Box does not show the FK control rotation correctly in Viewer. 

MOBU-628 No support for In-Place mode with HIK. 

MOBU-627 No support for Inverted joints in HIK. 

MOBU-1064 ORSDK sample ortoolpath3d crashes after File < New. 

MOBU-1063 ORSDK sample ortoolbatch crashes when executed twice. 

MOBU-1062 ORSDK sample ortoolmedia crashes after File < New. 

MOBU-1061 ORSDK sample ortoolgrabview3d doesn't reset the viewer on File > New. 

MOBU-1060 ORSDK sample orimpexptool hangs on File > New. 

MOBU-1058 ORSDK sample ortoolcluster not working correctly. 
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制限事項と回避策 

バグ番号 説明 

MOBU-1059 
ORSDK sample ortoolconstraint relation can crash with File< New followed by scene 
destroy. 

MOBU-1056 ORSDK sample ortoolcharacter crashes if executed twice. 

MOBU-1055 ORSDK sample ShadowMapping has missing files. 

MOBU-999 Layers added on merge.  

MOBU-997 Control Rig does not to support changing rotation order on the FK Controls.  

MOBU-927 Python KeyboardMapper script fails. 

MOBU-923 Undo the Perspective camera does not work. 

MOBU-901 FBScene function name NamespaceGetContentList param pModificationFlags has no 
effect on Namespace. 

MOBU-889 Cast shadow updates for Maya are not sent when using ‘Update current scene’ option. 

MOBU-888 HD Video in .mp4 format not playing in MotionBuilder.  

MOBU-864 Realistic shoulder solving not working with HIK 2013 for character to character 
retargeting. 

MOBU-852 ORSDK samples ortoolscene and ortooluidemo cause crash on exit if run 
simultaneously. 

MOBU-824 ORSDK sample solution has missing projects. 

MOBU-830 ORSDK sample running ortoolpath3d and ortoolplug simultaneously causes instability. 

MOBU-820 Full Screen mode does not fit the window when Video output is online. 

MOBU-740 Crash opening a recorded file recorded using a device plugin. 

MOBU-722 
Ghosts not rotating correctly in Motionblend.  
Workaround: It is recommended that animation blending be done in the Story tool. 

MOBU-715 Set a key on an object controlled by a relation does not generate expected T values. 

MOBU-676 

Plotting camera from switcher not considering layers.  
Workarounds: Since only the base layer is supported when plotting cameras from the 
camera switcher, plot all layers onto the base layer before plotting from the camera 
switcher. 
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制限事項と回避策 

バグ番号 説明 

MOBU-672 Cannot activate pinning via Python. 

MOBU-659 Motionblend does not maintain take start/end.  
Workaround: It is recommended that animation blending be done in the Story tool. 

MOBU-649 Exported clip from Story imports with changed clip length. 

MOBU-641 FBModelPath3D.PathKeySetLeftTangeant on the first vertex does not work. 

MOBU-625 
Creating new animation layer resets non-keyed modifications to object and control rig 
poses. Workaround: Create new layer before posing character or store the pose 
through the pose controls before creating the layer. 

MOBU-626 Problem with Parent Child constraint when Rotation Y = 180.  
Workaround: Replace parent child constraint with position and rotation constraints. 

MOBU-622 Namespace on take crashes software on Save Selection. 

MOBU-610 

Gimbals occurring on skeleton when keyed on layers.  
Workaround: Select gimbal joint and open Property View (Window>Add Property View) 
and disable Enable Rotation DOF from Degrees of Freedom>Rotation.  Or, switch 
rotation order to = Euler XYZ (Note: this may offset the motion slightly). 

MOBU-504 
Documentaton for FBDevice no longer contains Public Attribute for the Live Boolean on 
a device. 

MOBU-483 Loading character animation with layer animation can corrupt control rig animation.  
Workaround: Merge layers.  

MOBU-398 

Marquee selecting empty area in viewer or click-selecting empty area of Viewer causes 
unexpected selections.  
Workaround: Selection returns to normal by making the following modifications to the 
Property View Settings for objects being selected unexpectedly: Marker Settings > Look 
= Circle. 

MOBU-368 Constrained Effectors are not following parented objects.  

MOBU-312 
Translation on the root Joint of ASF Skeleton not retained when importing AMC motion 
file. 

MOBU-273 Crash setting device online after switching the resolution frame rate dropdown to the 
second 1920x1080 29.97 option. 

MOBU-239 Rag Doll animation mixing jitters when character is scaled very small.  
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制限事項と回避策 

バグ番号 説明 

MOBU-253 
Not possible to override Scale Inheritance>Scale Compensate when multi-selecting 
objects in the Viewer. 

MOBU-190 Key framing in quaternion using Python changes rotation values. 

MOBU-159 Performance drops when working with ghosts and razoring clips in Story. 

MOBU-141 Duplicating rigs with constraints does not correctly link duplicate constraints. 

PEEO-2258 Pinning in Body Part mode not working as expected with HIK solver. 

PEEO-2179 Video out is not updated when camera resolution is changed.  

PEEO-1914 New windows are undocked when custom layout is selected. 

PEEO-1912 Restore Window mode does not refresh active layout correctly. 

PEEO-2177 Live Shadow shader incompatible with alpha textures and transparency. 

PEEO-2193 Plot Selected (All Properties) on curves with quaternion rotation does not consider the 
constant key reducer. 

PEEO-2026 Audio output not being enumerated properly through Python SDK. 

MOBU-1186  

You cannot play the Essential Skills movies "Opening Sample Files" and "Selecting 
Body Parts" in Windows Media® Player.  
Workaround: Play the movies in Apple® QuickTime® Player version 7.7.1 by 
downloading QuickTime via the option “QuickTime 7.1 or greater recommended” in the 
Learning Movies window and by setting QuickTime as the default program for .mov files. 

注意事項 
このリリースでの注意事項を次に示します。 

ビデオ出力機能のハードウェア要件 

ビデオおよび外部同期の設定にアクセスするためには、ユーザは Nvidia Quadro SDI 出力カードを用

意する必要があります。 

[Save]および[Save As]の設定が記憶される 

保存オプションが変更された場合、これらの設定が[Save]および[Save As]の両方によって使用されま

す。 
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Autodesk, Backburner, FBX, Maya, MotionBuilder, Mudbox, Softimage, and 3ds Max are registered trademarks or 
trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other 
brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter 
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